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The ExamView® Assessment Suite 5.0 (including the Test Generator and Test

Manager) is a comprehensive solution for creating, administering, and scoring tests.
With the new version, it is easier than ever to prepare paper and online tests. The
software includes many features to save you time and generate information to assess
and improve student performance.

Use the ExamView Test Generator to...

o Create a paper test in less than five minutes.

e Print multiple versions of the same test.

e Enter your own questions.

e Prepare an online test, study guide, and worksheet.
e Upload tests to WebCT and Blackboard.

Use the ExamView Test Manager to...

o Create a class roster.
e Automatically score a paper test using a scanner.
e Administer and score an online test.

e Prepare a variety of useful class and student reports.

Our mission is to enhance the learning process by providing superior products for
students and educators. We believe that the ExamView Assessment Suite can truly
enhance your classroom experience.

One of the reasons our software is so widely used in classrooms is that we include
educators and students in the design process. We invite you to share your experiences
and feedback with us so we can make our products even better. Please email your
comments to support@fscreations.com.

To learn more about our products, visit our website at www.fscreations.com.
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System Requirements

To use the ExamView Assessment Suite, your computer must meet or exceed the
following requirements:

Windows

e PC with Pentium Il 120 MHz or higher processor

e Microsoft Windows 98 or later operating system

e 32 MB available memory for application (64 MB recommended)

e CD-ROM drive (for installation from disc)

e Monitor capable of displaying 16-bit color with 800 x 600 resolution
e 24 MB of available hard drive space

e Mouse (or another pointing device)

¢ Internet connection to access the test-hosting features

Macintosh

e PowerPC 120 MHz or higher processor

e 0S X 10.2 or later operating system

o 32 MB available memory for application (64 MB recommended)

e CD-ROM drive(for installation from disc)

¢ Monitor capable of displaying 16-bit color with 800 x 600 resolution
e 24 MB of available hard drive space

e Mouse (or another pointing device)

e Internet connection to access the test-hosting features

Note: The ExamView Assessment Suite includes a separate program called the
ExamView Test Player that you can use to deliver online tests on your local area
network. The system requirements are the same as those shown above except that the
application requires a minimum of 16 MB available memory for the application and 8 MB
of hard drive space.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 2



Installation Instructions

Follow these steps to install the ExamView Assessment Suite. The installer will create
an ExamView folder and these subfolders: Banks, Tests, Scanners, and Classes. If you
received the software from a publisher, the installer will automatically copy the
publisher-supplied question banks to a new folder within the Banks folder.

Windows

1.

Insert the ExamView disc into the CD-ROM drive of your computer.

If the autorun feature is enabled on your computer, a window will automatically
appear on your screen. Click the Install button and skip to step 5. If the autorun
window does not appear, proceed to step 2.

Click the Start button and choose Run.

In the Run window, type d:\setup.exe, replacing d with the drive letter that
corresponds to the drive where the setup file is located.

Click the OK button.
Follow the instructions that appear on your screen.
Note: To uninstall the ExamView software, choose Settings - Control Panel from

the Start menu. Select Add or Remove Programs. Removing the program does not
delete any banks or tests. You must manually remove those files.

Macintosh

1.

2.

Insert the ExamView disc into the CD-ROM drive of your computer.
Open the installer window, if necessary.

Double-click the ExamView installer icon.

Follow the instructions that appear on your screen.

Note: To uninstall the ExamView software, simply delete the program folder.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 3



Getting Started

After you complete the installation process, follow the instructions below to start the
software. Start the ExamView Test Generator if you want to create a test, open an
existing test, create new questions, or work with a question bank. Use the ExamView
Test Manager to create a new class roster, assign an online test to a class, get results
from an online test, score a paper test using a scanner, or print a report.

ExamView Test Generator

1. Windows: Click the ExamView Test Generator shortcut on your desktop. If you do
not have a shortcut, click the Start button. Highlight the Programs menu and locate
the ExamView Pro Test Generator folder. Select the ExamView Test Generator
option.

Macintosh: Click the ExamView Test Generator

icon in the dock. If you do not see this icon, locate Use the

the ExamView Pro folder on your hard drive. ExamView Test

Double-click the ExamView Test Generator icon. Generator to
create a test or

work with a

2. The first time you run the software, the program question bank.

prompts you to enter your name, school/institution
name, and city/state. Enter the requested
information.

3. Choose one of the options in the Startup menu.

Each time you run the ExamView Test Generator program, the program displays
the Startup menu. You can choose to create a test using the Test Builder or enter
your own questions using the Question Bank Editor.

[@ ExamView Test Generator - Startup
What do you want to do? All of the figures
are from the
<@ (%) Creste a nevw test using the QuickTest Wizard: Windows version.
Except for a few
Use the ExamView Test Builder to minor differences’
= .
I@ () Create a newe test tSr:)ere'\éI 2;'2:25h
‘;;a () Open an existing test identical.

Use the ExamView Question Bank Editor to

H ™ O Cregte & nevy guestion bank

[“Q’T.' O Open an exizting guestion bank
o] [ gonce
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ExamView Test Manager
1. Windows: Click the ExamView Test Manager

shortcut on your desktop. If you do not have a Use the
shortcut, click the Start button. Highlight the ExamView Test
Programs menu and locate the ExamView Pro Test Manager to
Generator folder. Select the ExamView Test assign an online
Manager option. test, get results,

or print reports.

Macintosh: Click the ExamView Test Manager icon

in the dock. If you do not see this icon, locate the

ExamView Pro folder on your hard drive. Double-click the ExamView Test Manager
icon.

2. Choose one of the options from the Startup menu.

Each time you run the ExamView Test Manager program, the program displays the
Startup menu. You can choose to start a new class or open an existing class.

-,

[ﬁj’ ExamView Test Manager

What do you want to do?

H"-? ] {:} Open an existing class

038 ] [ Cancel

Help Topics

Detailed help instructions are always available if you need assistance using the
ExamView software. Click the Help button or choose the Help Topics option from the
Help menu to view step-by-step instructions. If you have trouble while you are working
with the software, you may want to review the troubleshooting tips.
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The ExamView Test Generator program provides all the tools you need to create a
paper test or an online test from your own questions or from those provided by a
publisher. You can use the QuickTest Wizard to select the questions for a test, or you
can use one or more of the other question selection options.

After you create or build a test, you can change the instructions, reorder the
questions, change the layout, print the test, or publish an online test.

Use the QuickTest Wizard

If you want to create a test quickly with randomly selected questions from one or
more question banks, use the QuickTest Wizard. The wizard guides you through the
step-by-step process of selecting questions for a new test.

To create a test with the QuickTest Wizard...
You can also click

1. Launch the ExamView Test Generator. A startup the N button in
window with several options will appear. Choose the the toolbar to start
Create a new test using the QuickTest Wizard the QuickTest
option. Wizard.

2. Name your test.
3. Select the question banks from which you want to choose questions.

4. ldentify how many questions of each type you want on your test and click the Finish
button.

That’s all there is to it! If you want, you can customize the appearance of your test
using the many formatting options or you can select additional questions.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 6



1. Launch the ExamView Test Generator. A startup
window with several options will appear. Choose the

Build a New Test

The ExamView Test Generator offers several question selection options to create a
new test. You can use the QuickTest Wizard or one of the other six options. The option
you choose depends on your particular needs. For example, you can select questions
by viewing the actual questions and deciding which ones to include on your test. Or,
you can select questions by learning objective or standard.

To build a new test...

You can also click

Create a new test option. the Ll button in

the toolbar to

2. Name your test. create a new test.

3. Choose one of the question selection options from
the Select menu, or click the corresponding toolbar button.

T

81—

L F:
83—

Select Randomly - Choose this option if you want to select questions
randomly. You can choose how many questions you want for each question
type (e.g., multiple choice, true/false, short answer, etc.).

Select from a List - If you have a printout of your question banks, you can
manually review the questions and choose the ones you want to include on a
test by writing down the question numbers. Then, use this option to select the
question numbers from a list.

Select While Viewing - Use this selection method if you want to view the
guestions and make your selections one at a time while viewing them.

Select by Standard - If your questions include learning objectives, local
standards, state standards, or national standards, use this option to easily
select questions based on this information.

Select by Criteria - Choose this option to select questions that match criteria
you enter. For example, you can select all of the multiple choice questions
that cover a certain topic and include specific keywords.

Select All - Choose this option if you want to quickly select all of the questions
in a bank or group of banks.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 7



4. After you choose a question selection option, identify which question banks you
want to use to create the test.

Highlight one or more question banks and click the Select button. The question

banks you choose appear in the lower portion of the window. Click the Next button
to move to the next step.

Note: If the question bank(s) you want does not appear in the list, click the Folder
button to locate the question bank(s).

t‘j’ Select Questions From a List

Step 1:  Highlight the guestion banks yvou vwant to use and click the Select button.

1| Up one level

ExamView

672 Mt Sample 2
& science Sample 1
:@ Science Sample 2

E: CHExamyiew Banks\Samples

Banks: o

GQuestions: o

Cancel

5. Use the options provided to select the questions

that will appear on your test. If you need help

using any of the

Depending on which question selection option you selection options,
chose, the ExamView Test Generator displays a click the Help
window with the options you need to build a test. button for detailed

instructions.

6. Change the appearance of the test, print the test,
or publish it online.

7. Save the test.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 8



Customize the Appearance of a Test

ExamView Test Generator includes numerous features that allow you to customize the
appearance of a test to your exact specifications. A few of the more popular options
are listed here, but you can refer to the help topic Customizing the Appearance of a
Test for a complete list.

Answer Space

Depending on how your students will complete the test, you can turn on or off space
for answers. For example, if you want your students to write the answers on the test
next to each question, you can provide space to do so. If your students will be using a
bubble sheet or a separate piece of paper, you can show only the questions. Choose
Layout from the Test menu. Set the corresponding options in the Leave Answer Space
for area of the layout window.

Reordering Questions
Changing the order of questions is a snap. Just choose

Reorder from the Question menu, and you can drag You can manually
and drop the questions to your liking. Note, however, reorder or scramble
that questions must remain grouped by question type. questions. A]so,
You cannot move a single true/false question to a when you print a
position after the multiple choice questions. Instead, test, there is an
you must move the entire group of true/false g @ _scramble

. the questions.
questions.

If you want to scramble the questions, choose
Scramble from the Question menu. From there, you can choose to scramble sections,
questions, and the answer choices in multiple choice and multiple response questions.

Replace Font

If you want to change the font of your entire test, choose Replace Font from the Edit
menu. Select the fonts and sizes you want to use, and click the Replace All button. All
guestions in your test will instantly update with the newly selected font choices.

Note: If you use the Replace Font option to replace a font, it is best to replace one
font (e.g., Times New Roman) with another (e.g., Arial). Do not choose to replace all
fonts with another font. This could cause unintended results such as replacing symbols
or other special characters (e.g., Symbol).

Adjust Multiple Choice

Do you need to alter a multiple choice test for a special-needs student? Choose Adjust
Choices/Columns from the Question menu to adjust your test. You can instantly
reduce the number of choices in all of your multiple choice questions.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 9



Layout and Style

Several state and national test styles are built into the ExamView Test Generator.
Instantly format your test by choosing a style from the Style Gallery. For example, if
you want to format your test to look like the PSAT, choose Style Gallery from the Test
menu. Select the PSAT option and click the OK button.

If you do not see a style that suits you in the Style Gallery, you can customize the test
with the Layout and Style commands. Choose Layout from the Test menu, and set the
layout options. Then click the Style tab and choose your fonts and styles. The figure
below shows an example of a test with a customized bubble sheet style.

Name: Class: Date: 1D: A

Reading 10

Multiple Choice
Identify the letter of the choice that best completes the statement or answers the question.

Read the Alternative Fuel Vehicles passages, and then answer the following question(s).

1. Read this sentence from the first passage.

One of the biggest advantages of the EV is that it runs clean. without
harmful emissions.

What is the best synonym for the word emissions?
@ accidents @ irritants
® pollutants @ side effects

2. Refer to both passages. Which of the following statements about fuel cell technology is NOT true?
® The fuel cell vehicle is a zero-emission vehicle.
@ Fuel cells have been used on spacecraft for many years.
@ In fuel cell vehicles, hydrogen is burned directly in the engine, like gasoline.
@ The United States, Germany, and Iceland are investing in fuel cell technology.

3. Which adjective best describes the author's point of view in the first passage?
@ sincere © objective
® biased @ persuasive

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 10



Print a Paper Test

After you create or open a test, you can print a paper test in just a few simple steps.
When you choose to print a test, the ExamView Test Generator prints the test and

the answer key exactly how it appears on screen.
To print a test...
. . . x’_j
1. Choose Print from the File menu, or click the “—= toolbar button.
2. Set the print options.
If you choose 2 or more versions of the test, you can choose to scramble the
guestions using several options. If the test includes dynamic questions, the
ExamView Test Generator can calculate new values for each test.
As part of the test, you can print an answer strip to make it easier to score paper

tests, a bubble sheet form so that students can record their responses, and a
version map that identifies how questions align on each version of a test.

E@ Print Test

Test Versions

Mumber of test versions to print: 2 :

|:| Scramble zections (e.q., TruesFalze, Multiple Chaoice)
Scramble questions

Scramble multtiple choicefnultinle responze answer choices

[“]Calculate nevy algarthm values:

[ IPrint bubkle sheet
[IPrirt wersion map

) (o=

3. Click the OK button.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.
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Publish an Online Test

The ExamView Test Generator lets you publish a test in a variety of online formats.
Regardless of the online testing option you choose, the steps to build a test are the
same as those you use to create a paper test. The online testing options are listed
below.

Online testing options...

e Create an online test on your local area network (LAN).
e Publish a test using the ExamView Learning and Test Center.
e Save the test as an HTML document that you can post to your own website.

e Export the test for use with your WebCT or Blackboard course management
system.

e Publish a test to a third party’s website.

The online testing format that you choose depends on your specific needs. Refer to
the other sections in this manual for a complete description of the various options.
Detailed instructions are available to guide you through the process of publishing an
online test.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 12



When you build a test using the ExamView Test Generator, you do so by selecting
guestions from question banks. A question bank (or bank) is a collection of questions
and all of the related items (pictures, equations, learning objectives, standards, etc.)
stored in one file. Each question bank may contain up to 250 questions, but you can
have an unlimited number of banks. Typically, questions are organized into banks by
chapter or lesson.

Using the ExamView Test Generator, you can...

e Enter new questions or edit existing questions.
e Copy and paste questions from another source.
e Import questions from Word or an RTF file (with the EV Import Utility).

IMPORTANT: You can create a new question or edit a question while building a test.
However, editing a question after it is included on a test does not change the original
guestion in the question bank. You must edit questions or add new ones in a question
bank to make those questions available when you build your tests.

Question Bank Basics

If you have not used the ExamView Test Generator to create your own questions,
there are a few things to consider before you get started. For example, you can
include more information than just the question (e.g., answer, learning objective or
standard, student feedback, etc.). Take a few
moments to review the information presented here

i . You can use a
before you begin the next section.

bimodal question
as a short answer
or a multiple choice
Question Types guestion on a test.
When you create your own questions, you can include

one or more of the following question types.

True/False Yes/No Problem
Modified True/False Numeric Response Essay
Multiple Choice Completion Case
Multiple Response Matching Other
Bimodal Short Answer

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 13



Question Information

Questions can include optional information that is useful when creating a test. For
example, you can include learning objectives (or standards) and then select questions

based on those objectives.

You can also use this

information to generate class and student reports. You
can enter any or all of the following information with

each question.

Difficulty State Standard Topic
Reference Local Standard Keywords
Learning Objective  Miscellaneous Notes

National Standard

Student Feedback

Use the pipe (|)
character to enter
more than one
data element
such as a state
standard —

MA3-1.2 | MA4-1.

If you use the ExamView Assessment Suite to deliver online tests, you can include a
rationale and student feedback for each objective-based (e.g., multiple choice)
question. As a result, you can set up your online tests to display feedback for incorrect

responses.

[ Multiple Choice - 1 of 1

File Edit Miew Insert Format Table Help

Thisisa__ question.

LTJ ) F TimesMewRoman |+ (11 (| B T U === =
.Z.....‘.|..‘....2...|‘..3.‘.|..‘4...| .5
Ouestion

0 a TruefFalse

. {Mumenc Fespaonse

@0 Riitiple Thaice

Qc
{0 d { Completion

.]_Z [

Rationale

A multiple choice guestion includes .
- @ guestion stem and two or more ©

- up to eight choices

hoices

- choices arranged in one, two, or four columns
- choices identified by letters (ABCDE) or numbers (12345)

Feedback

True/False guestions do not include choices

Carrect!

Mumeric response guestions require you to enter a number

[=0 Wl l==b

Marrative... | (Mone)

w Answer: (b w

Completion guestions are similar to fill-in-the-hlank guestions.

l Record J I Infa... I [ Cloge

Scramble: | Al w

Choices: |4

Columns: |2

EXAMVIEW ASSESSMENT SUITE
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online tests, you
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Narratives

A narrative is a table, a descriptive passage, a special instruction, a picture, or other
information that can be attached to (or linked to) one or more questions. All questions
linked to the same narrative print together as a group on a test. Possible uses for a
narrative include a reading passage, map, chart, or photo.

Images

You can easily insert an image (e.g., graph, map, photo, etc.) into a question or an
answer. Or, you can copy and paste an image from another program. Whichever option
you use, be sure to consider the size and readability of

the image. You can edit a
question and
Color images and photos can use a lot of memory that, double-click an
in turn, increase the size of the test or question bank image to see how
file. For example, a single color photo can be 1-2 MB. much space it
For paper tests, the size of an image is not that critical. requires. You can
However, the image size does affect online tests. also reduce the
Imagine students downloading a test via the Internet color setting of
that includes three or four photos. If you use color the image.

images, use the lowest possible resolution.

If you plan to include an image in a question, you should check the image for
readability. Can you read the information on your screen and on paper? If you create
your own art, use a larger font for text that appears as part of an image. For best
results and smaller file sizes, use black and white or 256-color images.

Other Issues

If you create your own questions or edit existing questions, consider these additional
guidelines.

When you create your own questions...

¢ Do not write questions that refer to another question or depend on a particular
guestion order. Remember that you can scramble questions on a test. And, if
you randomly choose questions, you may not get all of the questions you need.

e Use tables, not tabs, if you need to create tabular material. Tables work much
better, especially for online tests.

e Use standard fonts (e.g., Times New Roman, Arial, etc.). If you use other fonts,
you may have difficulty sharing the question banks with someone who does not
have the fonts you used. This can be a problem for online tests too.

e For multiple choice and multiple response questions, be sure to set the scramble
options for questions that include choices such as All of the above or None of
the above. You would not want one of these choices to appear as choice a or b.

¢ Do not worry about entering the instructions for the questions. ExamView Test
Generator automatically includes the instructions when you create a test.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 15



A Hands-On Tutorial

This section provides a tutorial that will guide you step-by-step through the entire
process to create a question bank using the ExamView Test Generator. You will learn
how to create a variety of question types, save the bank, use a narrative, insert art,
enter question information, and print a question bank.

Create a New Question Bank
1. Start the ExamView Test Generator program.

2. Choose Create a new question bank from the Startup menu.

If you are currently working in the test builder, choose Switch to Question Bank
Editor from the File menu and then select the option to create a new bank.

¥ ExamView Test Generator - Startup

What do you want to do?

"& @?Create & neyy test using the QuickTest Wizard

Use the ExamView Test Builder to
O]
(:) Create a nevy test

(:) Open an existing test

\

Use the ExamView Question Bank Editor to
A
[1*‘\'- ‘:|-J (:) Create a nevy question bank

71@'?

[. :.;' () Open an existing gquestion bank

(o] (o]

3. Name the question bank ExamView Sample Bank and click the OK button.

An empty question bank page (except for the title) appears on your screen. If you
want to edit the title, simply double-click it and change the title.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc. 16



Enter True/False Questions
1. Click the New button at the bottom of the window.

2. Choose True/False and click the OK button.
The question entry screen for a true/false question will appear. Depending on the
guestion type, the entry screen provides different options. For example, the
multiple choice screen includes space to enter each choice.

3. Type the following question in the question entry area.

Using ExamView you cannot create different versions of the same test.

4. Use the pop-up answer box in the lower right corner of the window to set the
answer to False.

[@ True/False - 1 of 1
File Edit Wew Insett Format Table Help
ficy | y Bl [arial Tl [vl B I U == v ¢

2
@

.Z..-|...1...|...2...|...3...|...4..........1.
[

Question

lUsing ExamYiew you cannot create different wversion of the same test.

.Z.......1.......z.......3.......4.......5.....1.5.
[

Rationale

I Record I [ Infa... l [ Close
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5. Click the Info button at the bottom of the window.

7. Click the Record button.

You should see the question you just entered on the
guestion bank page. If you do not see the question
information immediately after the question, choose
Preferences from the Edit menu. Click the Layout
tab and select the options to show difficulty and
reference.

8. Proofread the question. If you need to make any
changes, double-click the question. Or, highlight it
and click the Edit button at the bottom of the
window.

Type Easy for the difficulty, 221-223 for the reference, and click the OK button.

By default, all
guestions are
assigned a value
of 1 point. You
can change the
points in the
Question Info
window.

9. Create two more true/false questions using the following information.

ExamView gives you almost complete control over the appearance of a test so
that you can customize it to meet your testing requirements.

ANS: T DIF: Easy REF: 245

Stylized text, fonts, and special characters cannot be used in a test question.

ANS: F DIF: Challenging REF: 237

Save the Question Bank

1. Proofread your work and make any changes as
needed.

2. Choose Save from the File menu.

3. Enter a question bank file name, and select a
location where you want to save the file.

4. Quit the program, or continue with the next part of
this tutorial.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.

Be sure to save
your question
bank on a regular
basis. From time
to time, make a
backup of your
files.
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Create Multiple Choice Questions with a Narrative

1. If necessary, start the program and choose to open the question bank for this

tutorial.

2. Click the New button, and choose to create a
multiple choice question.

3. Enter the following question, answer, and question
information.

Based on Table 1-1, ExamView 5.0 includes which
feature?

a. QuickTest Wizard

b. Internet Test-Hosting
c. Select by Standard

d. All of the above

ANS: D DIF: Average REF: 242-245

4. Set the answer to d.

You can press
Ctrl+N (Windows)
or Cmd+N
(Macintosh) to
create a new
guestion. Or,
choose New from
the Question
menu.

5. Choose a-c in the Scramble box to scramble choices a-c only when you create a

test, and set 1 for the columns.

6. Click the Narrative button, click New, and enter the following narrative.

Use the Table menu to insert a table. If you have time, format the table as shown
below. Center the information in the last two columns, shade the first row, and

make the column labels bold.

ExamView 4.0 ExamView 5.0
QuickTest Wizard Yes Yes
Multiple Response No Yes
Internet Test-Hosting Yes Yes
Spell Check Yes Yes
Select by Standard No Yes
Table 1-1

7. Enter EV Table 1-1 for the narrative name and click
the Record button.

8. Click the Done button to return to the question
entry window.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.

It is important to
use a unique
name for each
narrative you
create.
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9. Record the question.

When you record the question, both the question and the narrative appear

together.

10. Enter the following question, answer, and question information.

Based on Table 1-1, ExamView 4.0 does not include which feature?

. QuickTest Wizard

Select by Standard

a
b. Internet Test-Hosting
c
d

Spell Check

ANS: C

DIF: Average REF: 242-245

11.Click the Narrative pop-up (not the button) and choose the EV Table 1-1 narrative
to link this question to the table you already created.

12.Record the question, and be sure to save your work.

File Edit View Question Help

DR E & PONP S| [rx [v] ?

=

ExamView Samnle Bank

TRUE/FALSE

1.

1.

Using ExamView you cannot oreate different versions of the same test.

ANE: F PTS: 1 DIF: Easy REF: 221223

. ExamView gives you almost complete control over the appearance of a test so that you can customize

it to meet your testing requirements.

ANS: T PTE: 1 DIF: Easv REF: 243

. Stylized text, fonts, and spedial characters cannot be used in a testquestion.

ANS: F PTE: 1 DIF: Challenging REF: 237

MULTIPLE CHOICE

ExamView 4.0 ExamView 5.0
QuickTest Wizard Yes Yes
Multiple Response No Yes
Test-Hosting Yes Yes
Spell Chedd Yes Yes
Select by Standard No Yes
Table 1-1

Besed on Table 1-1, ExamView 5.0 includes which festure™
a3 QuidkTest Wizard

b. Internet Test-Hosting

c. Select by Standard

4. All of the sbove

ANE: D PTS: 1

. Basedon Table 1-1, ExamView 4.0 does not include which feature?

a3 QuidkTest Wizard

bt. Internst Test-Hosting
¢. Select by Standard
é. Spell Chede

ANE: C PTE: 1

Question bank title

Edit... Total questions in bank: 5

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.
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Enter Completion Questions and Run Spell Check

1.

2.

Choose to create a new completion question.

Enter the following question, answers, and question information.

Notice that the question has three possible answers. For online tests, students can

respond with any one of the answers.

ExamView is a computer

that allows you to build paper and online tests. Use the Shift key
and hyphen to

ANS: create the space

program to write an

application answer.

tool

DIF: Average REF: 247

Enter the next question, answer, and question information.

Use the online whenever you need additional
instructions to use the ExamView software.

ANS: help DIF: Easy REF: 251

. After you record the question, choose Spell Check from the Edit menu.

Save your work.

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.
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Create a Short Answer Question with a Picture

1.

2.

Choose to create a new short answer question.

Enter the following question, answer, and question information; but do not record
the question.

Describe the picture above. What format is used and how big is it?
ANS: Student answers will vary depending on the picture used.

DIF: Average REF: 277

Insert one or two blank lines above the question, and move the cursor to the first
line.

Choose Picture from the Insert menu, locate a picture, and insert it into the
question.

If you cannot find a picture, start a paint program and create a simple illustration.
Then, copy and paste the picture into the question.

After you insert a picture, double-click the image and choose the Picture tab.

This window shows the memory size for the image. You can also change the color
settings here.

File Edit View Ingsert Format Table Help

Remember to

[ ] & £ Avial vll10 |»|| B I U z; =E==(L|?
T ——— — hll‘—,‘mf ,,,,,,, — keep the memory
T s size of each

picture as small

s, -
2,
E v “ as possible.
1ew e <
xam 5
test generator =
Describe the picture above. What format is used and how big ig2
Size | Picture | web
Picture type
Z o current: | BEEEoior bitmap. . iv|  Memory size: 61kB
[ ANEWErT Optimal: | 24-bit bitmap
The picture shown in the question is the first thing | found on m
and it is 180[(.
Crop from
Student answers will vary depending on the picture used. Left: 0.0" : Top: 0.0 :
Right: T Bottom T
{None} .v. Question type:
o Reset
[ Record ] [ Info ] [ Close
Help sppy | [ ok | [ cancel |

6. Close the Format Picture window and record the question.
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Wrap Things Up
1. Save the question bank.

2. Print a copy of the questions and review them.
3. Make any needed changes.

Remember that you can double-click a question or narrative to edit it. Or, you can
highlight an item and click the Edit button.

If you want, switch to the Test Builder using the File menu and choose to create a
new test. Use the questions you just entered to build your test. Notice that as you

build the test, the instructions automatically appear.

4. Quit the program.
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Copy and Paste Questions

If you have questions in another format (e.g., word processor, another test generator,
database, etc.), you can copy and paste questions from that program into the
ExamView Test Generator. While this is a simple process, it can be time consuming.
Usually, the copy and paste method is best for just a few questions.

Note: If you have many questions in a word processor format such as Microsoft Word,
you can use the import utility to import your questions quickly. Refer to the next
section for instructions.

To copy and paste questions...
1. Choose to create a new question in a question bank or a test.

2. Highlight and copy the text (e.g., from your word processor) that you want to paste
into a question.

3. Switch to the ExamView Test Generator question entry window.
4. Paste the text into the question.

Depending on the question type, you may have to copy and paste the question
separately from the answer. However, you can quickly copy/paste multiple choice
and multiple response questions. Using the SmartPaste option, you can
automatically copy the choices into the appropriate places in the question entry
window.

To use SmartPaste, highlight an entire multiple choice or multiple response
question including the choices (a. b. c. d. e.) in your word processor and select
Copy. Switch to the question entry window and press F7 (not Ctrl+V or Paste). Use
Cmd+P on the Macintosh.

Import Questions from a Word Processor

If you have all or most of your questions in a word processor format such as Microsoft
Word, you can use the EV Import Utility (installed with the other ExamView programs)
to import your questions into the ExamView Test Generator format very quickly. The
program includes step-by-step instructions that explain how to import your questions.
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The ExamView Test Manager provides the features you need to track results for paper
and online tests. To begin, you must create a new class. Then, you can manually enter
the student information or import a roster from another format such as your
gradebook. Follow the steps in the appropriate section to create a new class and enter
your roster.

IMPORTANT: You do not have to create a new class if you do not plan to track
student results or give online tests.

Create a New Class

Before you enter student information, you must create a new class. To do so, you must
enter information about your class (e.g., class name, class ID, period, and section) and
yourself (name, ID, school name, school ID, city, and state). Just a few of the fields
are required. Other fields, such as the password and school ID, are optional.

To create a new class...

1. Launch the ExamView Test Manager. A startup
window with two options will appear. Choose the
Start a new class option.

You can change the
information at any
time by choosing
Class Information in
If you are already working with the ExamView the Edit menu.
Test Manager, save the current class and choose

New Class from the File menu.
2. Enter the class name and other fields as needed.
3. Enter your name, school name, city, and state. The other fields are optional.

4. Click the OK button to record the class information.

[ New Class

Class Information
m Clazs name;

sy Class ID: (optianai)

Period: (aptional)

Section; faptional)

Password: faptional)

Confirm password: Preferences...
InstructorSchool Information

Instructor name:

Instructor 0 faptional)
School name:

School ID: faptional)

City: StateRegion:

EXAMVIEW ASSESSMENT SUITE
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Enter Student Names and IDs Manually

After you create a new class, the next step is to enter your students. At a minimum,
you must enter each student’s name and assign an ID. You may also enter an alias and
a password. ExamView Test Manager provides an option to show the alias instead of
the name and ID on reports. You can assign a unique password to each student to use

when taking an online (LAN) test.

ExamView Test Manager allows you to generate reports using optional demographic
information such as gender, socio-economic factors, race, and custom fields (e.g.,
instructor, location, etc.). Simply click the More button in the New Student window

to display the data entry fields to record this information.

To enter student information manually...

1. Continue from the previous section where you created a new class. Or, start the
ExamView Test Manager to begin a new class or open an existing class.

2. Click the "&3‘ toolbar button or choose Add New
Student from the Student menu.

3. Enter the student’s first name, last name, and ID.

Note: If you plan to use a scanner, use digits only
(e.g., 520403) for the ID. Most scanner forms
provide for numeric IDs only. For online testing, use
unique student IDs across all of your classes.

4. Click the Next button to record the student.

The alias and
password fields
are optional.

Click More to
view additional
student fields.

When you click the Next button the program records the student and clears the

data entry field so that you can enter the next student.

@ Hew Student

TWp

o

Help

Student Information

First name:

Last name:

Studert D

Student Alias:

Pazswward:

Ok ] [ Cancel

5. Repeat steps 3 and 4 to enter all of your students.

6. Click the OK button when you are finished entering students.

EXAMVIEW ASSESSMENT SUITE
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Import a Student Roster

The ExamView Test Manager makes it easy to import your students from another file.
At a minimum, the file must include the student’s first name, last name, and ID. The
file must be a text file but can include the fields in any order along with other
information. In just a few steps you can identify the pertinent information and start

the import process.

To import student information...

1. Start the ExamView Test Manager to begin a new class or open an existing class.

2. Choose Import from the File menu.

3. Select the .txt or .csv file that includes the students’

names and IDs.

4. Click the pop-up menus in the First Data Record from
File column to identify the data to import.

5. Click the OK button to import the student

information.

[ﬂ’ Import Class Roster

=,

Preview
Iher Alexander

Boehl MNorman

First name:
Last name:
Student 1D
Pazsword:

Student alias:

Balbba Andy 605605268605

ExamView Test Manager Field

Import file:  CDocuments and Settings'Chriz Schaber\Desktophmy roster tx

104681655 hbher
Baba
379044498 Boehl

|:| First recard in the import file is & header

First Data Record from File

Alexander W
Aher w
H04681655 [
[emipty] b
(empty] b
Ok ] [ Cancel

EXAMVIEW ASSESSMENT SUITE
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You can import
your class roster
from another
program such as
your gradebook.
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Using the ExamView Test Manager, you can easily score student assignments with a
scanner. Currently, the program supports the following scanners:  Apperson
Advantage™ 1200 (www.appersonedu.com) and the Pearson/NCS EZData® scanner
(www.pearsonncs.com).

When you use a scanner to score your students’ tests, you...

e Save time.
e Get detailed results data.

Saving time is an obvious advantage. Scanner technology makes it easy to score
multiple choice, multiple response, and true/false questions. If a test includes both
objective and open-ended questions, you can score the
objective questions with a scanner and then manually
score the open-ended questions, recording the points
earned for those questions.

A scanner makes

scoring tests and

quizzes quick and
easy. And, you

The primary purpose of the ExamView Test Manager is get detailed
gathering detailed performance data to help you make results for your
effective decisions. A scanner provides a means to class.

gather the data from paper tests to score your students’

work and generate various reports. If your tests include

learning objectives, state standards, etc., you can then use that information to
pinpoint areas where individual students need additional help. You can also use that
data to identify trends for your entire class.

IMPORTANT: You must use specific forms with the scanners. Go to our website
(www.fscreations.com) for a complete list of supported scanners.

PEARSON
APPERSON 5 g
Education Products NCS

EZData™ OMR Scanner

Advantage

CAIOEI aace
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Build a Test and Create an Assignment

Before you can score a test using a scanner, you must build the test using the
ExamView Test Generator and then create an assignment in the ExamView Test
Manager. When vyou create the assignment, the ExamView Test Manager
automatically opens the test file and reads the following information for each question
(if available): answer, reference, learning objective, local standard, state standard,

national standard, and points.

To build a test and create an assignment...

1. Start the ExamView Test Generator, build a test, and save it.

Scanning works only with objective questions such as multiple choice, multiple
response, and true/false. However, your test can include open-ended questions

such as short answer or essay. You must manually score those questions and record

the points.

Note: If you plan to administer multiple
(scrambled) versions of a test, create one
version, print it, and then save the file.
Scramble the test to create the next version,
print it, and save the test. For each unique test,
you must create a separate assignment.

@ 2. Start the ExamView Test Manager and choose
to open a class.

3. Click % or choose Create New Assignment
from the Assignment menu.

4. Enter the assignment name, category, term, and date.

[ New Assignment

The Examiewy Test Manager allowes you to track studert test results. To collect
the results, you need to creste & test sssignment. Results can be collected from
paper tests using & scanner or automatically from an online test.

Step 1: Enter the azsignment name, 10, category, term, and date.

Aszsignment name: |

Azsignment 10 faptional)
Category: | Benchmark w
Term: |1 = Date: |04/29/2005

[

You can administer tests in several ways—on paper, over a local area network,
using the Internet, or through any combination of these methods .

Step 2: Select the way(s) the test will be administered.
|:| Paper test scored manually or with & scanner
|:| Online test delivered over a local ares network (LARN)
|:| Online test publizhed to the ExamView test-hosting website

Cancel

EXAMVIEW ASSESSMENT SUITE © FSCreations, Inc.

If your test includes
objective and open-
ended questions,
place the objective
guestions (e.g.,
multiple choice) at
the beginning of the
test.
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5. Choose the Paper test scored manually or with a scanner option to identify how
you will administer the test. Click the Next button.

6. Select the file name that corresponds to the test

you created in the ExamView Test Generator. You can click the
Click the Next button. Preview Test

button to make sure
When you click the Next button, the program that you are

selecting the correct

reads the answer key and other information that
test.

it needs to scan and score the test.

Note: If necessary, click the Folder button to
locate your test.

7. Review the summary information, and click the Finish button to complete the
process.

After you create the assignment, it appears in the ExamView Test Manager work
area. Notice the shaded area in the figure below. The program shows the
assignment title, date, category, term, and possible points. A placeholder (--)
appears for each score.

You will learn how to get results from a scanner in the next section.

[\f mathematics.cls - ExamView Test Manager
File Edit WYew Student Assignment Report Help
DB L = &% Sk
FSCreations, Inc. d s
Mathematics e
Christopher R. Schaker N
& R
&
2
O7ing
Test
Term 1
| sopts
Mame Studert ID Score
Aber, Alexander 104681655 6%
Baba, Andy BSES2E365 74%
Boehl, Morman 579044495 0%
Campag, Manuel 218031585 4%
Coston, Denise 527344811 E8%
Droveecly, Whilbert 013103310 0%
Farweel, Chris 346695870 80%
Gibbong, Michael 431603314 78%
Hamlett, Ken 015922956 0%
Henderson, Sherman 452946293 8%
Hutter, Jean 911832166 BO%
Harthaus, Detlet 203996934 4%
Kretten, Carl 114964396 6%
Loetfle, Karsten E77962071 T4%
MoDowell, Geralding 467832015 78%
Martler, Randolph B03934704 4%
Cr'Meill, Brian E593375122 T4%
Pitzer, Debbie 8EEE31735 B3%
Rhodes, Jackie G585471963 65% I
25 students, 1 assignment
Mewy Studert... ] [ Mewy Azsignmert... ] [ Editt.... ] [ Delete
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Get Results from a Scanner

After you create an assignment, the next step is to administer the test and scan the
forms to get the results into the ExamView Test Manager. Scanning the forms reads
the students’ responses for each question. The program stores the information for
each student and automatically calculates each score based on the point values
assigned to the questions.

IMPORTANT: You can only score objective questions (e.g., multiple choice, multiple
response, yes/no, and true/false) using a scanner. However, your test may include
open-ended questions that you can score manually using the Edit Scores option.

To get results from a scanner...

1.

8.

9.

Launch the ExamView Test Manager and open ExamView Test

the class. Manager includes
the capability to get

Select (highlight) the assignment that you will be results from paper

scoring. and online tests.

Click the r_El toolbar button, or choose Get
Results from Scanner from the Assignment
menu.

Select the scanner and form.

Set the port to which the scanner is connected (if necessary), or click the Detect
Scanner button to automatically set the port.

Set the beginning question number.
Click the Next button to move to the next screen.
Scan the forms.

Click the Finish button to stop scanning.

General Notes...

o Verify that the scanner is connected properly before you try to scan the forms.
If you have trouble with the scanner, contact the manufacturer for support.

e You must use forms specifically designed to work with the ExamView Test
Manager software. Go to our website (www.fscreations.com) for more
information.

¢ You may include up to 100 objective questions on a test. If you have more than
100 questions, divide the test into two parts and create separate assignments.
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Place the objective questions at the beginning of the test and number the
guestions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.).

If you have problem with a form, you can make corrections and then re-scan it.
If necessary, you can manually enter the points earned.

You can use forms for several assignments. For example, you can administer and
scan a quiz with 10 questions. For the next quiz, set the beginning question
number to 11 and assign your students to fill in the bubbles for questions 11-20.
You can include matching questions, but the choices are limited to 5 choices (A-
E). Or, you can include matching questions and score the questions manually.
The software allows you to get results for an assignment from multiple sources.
For example, you could administer a paper test to part of the class and an
online test to other students.

You can scan forms in multiple sessions.

If there are problems with a student’s form: missing responses, multiple
responses, out of range (e.g., entering an E if only A-D valid), etc., an asterisk
(*) will appear next to that student’s name. Click the Stop Scanning button,
highlight the student’s name, and click the Edit button. You can change the
response for any item. Click the Resume Scanning button to continue.

Apperson Advantage 1200 Notes...

If the scanner becomes unresponsive, click the Stop Scanning button, press the
Reset Options button (located on the scanner), and then click the Resume
Scanning button. If that does not solve the problem, cancel the scanning
process. Turn the scanner off; turn the scanner on; and try to scan the forms
again.

The Apperson scanner prints the percentage score on the scanner form. For tests
with only objective questions all set to 1 point, the score will be correct. If your
test includes open-ended questions, the score printed on the form will not
reflect the open-ended questions. Unfortunately, there is no way to turn off
printing. However, you can remove the print cartridges.

Pearson/NCS EZData Notes...

If the status light turns an orange color, contact the manufacturer for
assistance. A problem may occur if there is a conflict between the scanner and
another hardware device.

If you notice that the information is regularly misreading student responses,
follow the manufacturer’s guidelines for cleaning the scanner.

You must use forms specifically designed the EZData scanner. Visit our website
(www.fscreations.com) for information.
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The ExamView Assessment Suite includes all of the tools you need to create and
administer online tests on your local area network (LAN). Use the online testing
features to save time grading tests and generate the information to improve student
performance.

You can create online tests that anyone can take using your local area network (LAN),
or you can assign a roster to an online test. For example, you can use the ExamView
Test Generator to create self-grading practice tests (or study guides) that provide
feedback for incorrect responses. You can also use this testing option to administer
chapter tests, quizzes, benchmark tests, homework, and worksheets. Then, use the
ExamView Test Manager to get results from an online test and produce reports.

Before You Begin

Before students can take tests using your local area network (LAN), you must get ready
for online testing.

1. Talk to your network administrator to secure space

on your local area network to put the online tests. Talk to your
network
You and your students both need read/write (full) administrator to
access to the network folder. get everything
set up before you
2. Ask your network administrator to install the EV Test publish an online

Player on your network and to place a shortcut on test.

each workstation to access the program. Or, you can
install the player program on each computer.

Advanced: For the Windows version of the EV Test Player, you can create a
shortcut for the program and set the target properties to include the following
options. For example, set the target to c:\examview\evpro.exe /nobrowse.

/nobrowse This option turns off the option for students to change the path
(or location) of the tests.

/noprefs This option directs the program not to write the preferences to
the local computer.

/testpath= This option allows you to set the default path for the tests.

3. Start the ExamView Test Generator, choose Preferences from the Edit menu, and
set the default online (LAN) path to the location on the network.
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Create an Online (LAN) Test without a Roster

You can publish an online test with or without a roster for your students to take on
your local area network (LAN). If you choose to publish a test without a roster, the
program automatically scores the test. Anyone may take the test; however, the results
are only available immediately after a student completes a test. No results are stored
in the ExamView Test Manager, and you will not be able to prepare any student/class
reports.

To create and publish an online (LAN) test that anyone can take...

1. Start the ExamView Test Generator and create or

open a test. Results are not
- stored for online
2. Click @ or choose Publish Online Test from the tests without a

roster. These
tests are great
for practice tests
and homework.

File menu.
3. Enter a test title.

4. Choose the Publish the test to a local network for
use with the ExamView Player option and click the Next button.

[ Publish Online Test g

Exam'iew requires that you enter & name for the online test. By default, the
test title wil be the same as you ertered when you intially created your test

Step 1: Enter a name for the test.

Test title: | Sample Onling Test

Thete are several ways to administer an onling test—using & local-area
network, saving the test as an HTML test, or publizhing the test directly to a
weebsite (2., Examiiew test-hosting site). Click the Help button for more
information.

Step 2: Select howw the test will be administered.
t:g} Publizh the test to a local network for use with the Examiiew Player
t':.‘ Save the test as an HTML document to your hard drive
() Publish test ta: .Exara\.u"i.ew .Testu-.}-!;s.ﬁﬁ.g Websrte v

5. Select the Allow access to anyone option and click the Next button.

6. Follow the steps to set the remaining options (i.e., password, student feedback,
question order, and reports) for the online test.

The program provides numerous options that allow you to customize the online

testing experience for your students’ needs. Click the Help button to view detailed
information about the online testing options.
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7. Review the test summary information and click the Save button to save the online
test to your local area network (LAN).

[ Publish Onfine Test
Review the summary information shown belowe, If you need to make changes, YOU can set the
click the Back button and return to the appropriste step.
default folder
= The test files will be saved to your local hard drive or local network. - h
= Anyone can take this online test (no results will be recorded). us' ng t e
= Students must enter a password Prefe rences
= Students can check their response to each guestion 99 times. Feedback wil a = =
be dizplayed for incorrect responses. Optl On |n the Ed |t
= After completing the test, students will see a detailed report for all questions.
Students can print the report. menu.
Click Save and choose a filename for your test. You should save the testto a
location that your students can access.
<Back |[ Save.. | [ Cancel

Note: When you save the online test, the program saves a specially formatted copy
of the test (with an .eot extension) to the location you specified. Remember that
your students must access the test file on the local area network (LAN). If you saved
the test to your hard drive, you must copy the online test (.eot, not .tst) to your
network.

8. If your test includes links to any multimedia files, you must copy those files
manually to the same location as the online test.

Students can now take the online test. See the Take a Test with the Test Player
section.

IMPORTANT: Preview the online test to make sure that everything is working. If you
notice an error, make changes to the original test and publish it again.
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Create an Online (LAN) Test with a Roster

With the ExamView Assessment Suite, you can easily track student test results. When
students take an online test, the program automatically scores the objective questions
and stores the information in a database. Then you can produce a variety of reports
and/or copy the results to your gradebook.

To create an online test with a roster, you must first build and publish the online test
using the ExamView Test Generator. Then, you must complete the process by
creating an assignment in the ExamView Test Manager program.

To create a test, publish the test, and track results for selected students...
1. Start the ExamView Test Generator and create or open a test.

2. Click Q: or choose Publish Online Test from the File menu.

3. Enter a test title.

4. Choose the Publish the test to a local network for use with the ExamView Player
option and click the Next button.

[ Publish Online Test |
ExamView requires that you enter & name for the online test. By defaut, the If yOU I nC I Ude

test tithe will be the same as you entered when you inftially crested your test.
open-ended
questions, it is

easy to score
student responses

There are several ways to administer an online test—using a local-area

netvrork, saving the test as an HTWL test, or puklishing the test directly to a m an ual Iy -
wwebsite (e.0., Examyiew test-hosting site). Click the Help button for more
information.

Step 1:  Enter a name for the test

Test title: | Sample Online Test

Step 21 Select how the test will be administered.
G) Publish the test to a local netweork for use with the Examyiew Player
':‘ Save the test a3 an HTML document to your hard drive

() publishtesttn: | Examiiew Test-Hosting Website ~|

5. Choose the Allow access to students in a particular class option and click Next.

6. Review the summary information and click the Save button to save the online test.
Note: When you save the online test, the program saves a copy of the test (with an
.eot extension) to the location you specified. Remember that your students must
access that location on the local area network (LAN). If you saved the test to your

hard drive, you must copy the online test (.eot, not .tst) to your network.

7. If your test includes links to any multimedia files, you must copy those files
manually to the same location as the online test.
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To assign an online test to a class...

@ 1. Start the ExamView Test Manager (if necessary).

After you publish an online test, you must complete the process by creating an
assignment for that class.

2. Open a class file.
3. Click {‘% or choose the Create New Assignment option from the Assignment menu.

4. Enter the assignment name, category, term, and date.

[ Mew Assignment

The Exam‘iew Test Manager allows you to track student test results. To collect
the results, you need to creste a test assignment. Results can be collected from
paper tests using a scanner or automatically from an online test.

Step 1: Enter the assignment narme, [0, category, term, and date.

Azsignment name: |

Azzignment 10: (optional)
Category: | Benchmark -
Term: |1 = Date: |04/20/2005

ou can administer tests in several ways—on paper, over a local area network,
uzing the Internet, or through any combinstion of these methods.

Step 2: Select the way(=) the test will he administered.
|:| Paper test scored manually or with & scanner
|:| Online test delivered over a local area network (LARN)
|:| Cnline test published to the Exam'iew test-hosting website

Cancel

5. Choose the Online test delivered over a local area network (LAN) option to
identify how you will administer the test. Click the Next button.

6. Select the file name that corresponds to the test

you published in the ExamView Test Generator. Select an ExamView
online test (.eot),
7. You can allow your students to complete the not a regular test

test multiple times or over multiple sessions. (-tst) file name.

Select the appropriate option(s) and click the

Next button. You can preview a

test to make sure it

] is the right one.
If you allow students to complete an online test

over multiple sessions, the program will save
their work and let them continue where they
left off in a prior session.
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8. Follow the steps to set the remaining options (i.e., password, student feedback,

guestion order, time limit, and reports) for the online test.

The program provides numerous options that allow you to customize the online

testing experience for your students’ needs. Click the Help button to view detailed

information about the online testing options.

[ New Assignment @

Stucents are required to enter & password before they can access the test. If
you want all students to use the same password, or it some students have not
been assigned individual passwords, enter & password below.

Step & Enter s password reguired to access the test.
Paszsword:
"3) Use only for students with no assigned password

() Use for all students

Students may take the test anytime they want, or you may limit access to this
onling test to & specific range of dates

Step 5: Specify when studerts may take this online test
@- Studlerts may access this test anytime
O Studerts may access this test

fram 124M [wi 00 s
to 122 |w|: o0 [se]

DS‘tudents may reviewe their test results after

= Back ][ et = 1 [ Cancel

9. Review the summary information and click the Finish button.

After you create the assignment, it appears in the ExamView Test Manager work
area. Notice the highlighted area in the figure below shows the assignment title,
date, category, term, and possible points. A placeholder (--) is set for each

student’s score.

NEX

[ mathematics.cls - ExamView Test Manager
File Edit Wiew Student Assignment Report Help
e = O
Dy E L [ & B o | P
FSCreations, Inc. .
Mathematics &
Christopher R. Schaber N
E,Di\naq
Ry
aring
Test
Term 1
| sopts
Mame Student ID Score
Aber, Mlexander 104661655
Bakba, Anchy BSES26BES
Boehl, Morman 379044433
Campadg, Manuel 218031585
Coston, Denise 527544811
Doy, Wilbert 0113105510
Farwell, Chris 346695570
Gibhons, Michael 431603314
Hamlett, Ken ME922958
Henderson, Sherman 452046293
Hutter, Jean 911532166
Karthaus, Detlef 203996934
Kretten, Carl 114964396
Loefle, Karsten EFTIE2071
mcDoweel, Geralding 4678320135
Martlet, Randolph E05954704
235 students, 1 assignment
l Mew Student... ] [ Mewy Assignment... ] [ Eciit.. ] [ Delete ]
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10. You should preview the online test to make sure that the test itself and online
settings are correct.

IMPORTANT: To preview a test with a roster, start the EV Test Player and use one
of your student’s IDs to access the test. When you finish, go to the ExamView Test
Manager. Open the class file, select the assignment, and choose the Get Results
from a LAN Test option. You should see the score for that student. Next, highlight
(select) the student record and choose Clear Student Results from the Student
menu. Be sure to clear the results for only the test you just previewed. Be sure to
choose the Update Online Tests option in the File menu to apply the updates to the
online test.

Notes...

e You can assign the same online test to multiple classes. Simply open another
class file and create an assignment. Point to the same online test when you
create the assignment. Make sure that your students’ IDs are unique across all
classes.

e If you need to make any changes to the online settings (e.g., change the
password, edit the reporting options, etc.), choose the Edit Assignment
Information option from the Assignment menu.

o If you notice mistakes in questions, misspelled words, etc. before any students
take a test, make your changes to the original test and publish it again.
IMPORTANT: You must delete the assignment from the class and then create a
new one. Otherwise, the answer key and other information will not match the
online test.

o If you notice mistakes in questions, misspelled words, etc. after any students
take a test, you cannot make changes to the test. However, you can adjust the
points earned to adjust students’ scores as needed.

e If you identify an incorrect answer or point value, choose the Edit Assignment
Information option from the Assignment menu. Click the Questions tab and
change the information. You can change an answer or point value anytime
without re-publishing the test. These changes are not updated in the actual
test, but they are applied to the students’ results.
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Take a Test with the Test Player

For tests that you administer on your local area network (LAN), students must use the
ExamView Test Player to take the test. Before your students can take the test, make
sure that the program is installed on your network and that students have read/write

(full) access to the folder where the test is located.

You can include any question type (multiple choice, true/false, numeric response,
completion, essay, etc.) on an online test. The program automatically scores any
objective (e.g., multiple choice), completion, or numeric response questions. You must
manually score any open-ended (e.g., essay) questions as described in the next

section—Get Results from a LAN Test.

To take an online test...

@ 1. Start the ExamView Test Player program.

2. Enter the student name and ID. Click the Next button to continue.

@ ExamView Test Player

Welcome to the Examiew Test Playver. “ou can use this program to
take & test at your computer .

Betore you take an online test, you need to enter your name and
student ID. K you do not knowy vour student 1D, consutt your
instructor.

Step 1: Enter ywour name and studert 1D,

Mame: | John Sanchez

D | J5103-2

[ medt= | [ Exit

3. Select the test and click the Next button.

If you do not see the test listed, click the Folder
button to change the location (if necessary). The
program will show only those tests that the student
may access. For example, if you set a date range
when the test is available, you will not see the test if
the current date is not in that range.
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enters their ID
incorrectly, no
tests will appear
in the list.
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4. Review the test information and click the Start button to begin the test.

The ExamView Test Player displays one question at a time. Students can answer a
question by clicking the radio buttons, clicking the choice buttons, or by typing a

response.

@ Sample Test - ExamView Test Player

METx)

File Edit Test Help

Hame: John Sanchez I JS103-2

Question 1 of 10 iple Choice) |

Count the apples in the two groups.
Write how many there are in all.

and i

is in all.

oA. 5and1is6inall oC. 6and1is7inall
oB. 5and1is5inall oD. 6and2is8inall

==

Help Score GoTo End

Answer
®EOE

Unanswered questions: 10

e )0m)

Question 1 of 10

The options available to the student depend on the online settings. For example, if
you set the option to allow students to check their work, the Score button appears
at the bottom of the window. If you set a time limit, a timer is displayed.

Get in the habit of previewing a test to make sure that you selected the appropriate

settings.

5. Respond to each question. Click the Next button or
press Page Down to go to the next question.

6. Click the End button when you are finished.

Depending on the reporting options you set, a report
will appear.

7. Click the Exit button to quit the program, or click
the New button to start a new test.
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You can set an
option to show
the end-of-test
report and
whether students
can print the
report.
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Get Results from a LAN Test

After your students take an online test, the next step is to get the results into the
ExamView Test Manager. When you perform this step, the program reads the results
and stores the data in the class record. If your test
includes open-ended questions, you must manually score

the questions and record the points earned.

To get results from a LAN test...

@l 1. Start the ExamView Test Manager program.

2. Select (highlight) the assignment for which you want

to get results.

Remember, that
student results
are stored only
for online tests
that you assigned
to a class.

[
3. Click &. or choose the Get Results from LAN Test option from the Assignment

menu.

The program automatically locates the online test file (with an .eot extension) and
reads the results from it. If you moved the file, you must locate it.

4. If your test included open-ended questions or you need to change a student’s score,
select the assignment and choose the Edit Scores option from the Assignment

menu.

The Edit Test Scores window shows you how your students answered each question
and the points earned. Select a student. For open-ended questions, select a
guestion. The student’s response appears for your review. Read the response and
enter the points earned. Click the Next button to move to the open-ended question
for the next student. You can change the points earned for any other question too.

@ Edit Test Scores—Sample Test

#len, Laurie e,
Estes, Amy ‘E‘
Frankston, Mary ’q 4
Manrae, Julie
Sanchez, John if

i Question
Sehastin, Mark #: Type

1:MC

ZMC
FMC
4MC
SMC
E:hC
T:MC
M
LM
10:PR

Correct
Answer

Student
Response

aooloooeoo
I
a0 o oooooo

=
r
@
=1

Student Response

Possible
Points

Erter or edit the poirts earned for individual gquestions. If you wart to view a particular test
guestion, tab to the appropriate gquestion number, and click the View Question button. To
edit scores for s different student, click on the studert's name

Points
Earned

= R U B G G P DG

o

10
-2

=3

<< Previous | [ mext== | [ _Hep

[!iaw@uesﬁnn ] [ Reset

] I Done
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Using the ExamView Test Generator, you can publish an online test in several ways.
One of those ways is to publish a test/assignment directly to an Internet test-hosting
service called the Learning and Test Center. A test-hosting service offers these
advantages: (1) publish to the Internet with just a few mouse clicks; (2) results
tracking and reporting; (3) control over when and who takes a test; and (4) no
additional hardware or maintenance costs.

FSCreations, Inc. (the developers of the ExamView Assessment Suite) offers an
optional test-hosting service on an annual subscription basis. For more information and
pricing, visit our website at www.fscreations.com.

With the Learning and Test Center, you can...

e Publish a self-grading practice test in just a few steps that your students can
take from anywhere they have access to a computer and the Internet.

e Administer homework and automatically score it without any additional effort
on your part.

o Deliver benchmark tests to a class or an entire school.
e Produce numerous reports that let you track student performance by standard.

Other companies may offer an online service. Check with your sales representative
or visit their website for more details. If you do have access to a third-party service,
follow the steps below to publish a test. However, be sure to choose the appropriate
option from the Publish test to: pop-up menu. After you publish the test, refer to
the instructions for that service to administer the assessment. IMPORTANT: You will
not use the ExamView Instructor Center or Learning and Test Center to administer
tests published to another service.

Register for the Test-Hosting Service

Before you use the ExamView Learning and Test Center, you must purchase a
certificate number and then use it to register for an account. When you register, you
receive an instructor ID and a password.

To register for an account...
After you register

1. Visit www.fscreations.com/examview.php and click online at the
the Instructor Center link. FSCreations
website, you can
2. Click the Register link and follow the instructions to change your ID
sign up for the service. and/or password.

Be sure to record your instructor ID and password.
You will also receive an email with this information.

3. Quit the browser when you finish.
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Publish a Test or Assignment

Publishing a test/assignment (regular or self-scoring) to the ExamView Learning and
Test Center is a very simple process. Within minutes, you can create a test or an
assignment for students to take online. Test or homework results are available
immediately after your students complete the assignment.

To publish an assignment...

1. Start the ExamView Test Generator, and create or

open a test. If you have_: an
account with

another service,
select it from the
Publish to: pop-
up and enter the
3. Enter a title for the test/assignment. appropriate 1D

and password.

2. Click @ or choose the Publish Online Test option
from the File menu.

4. Select Publish test to: with the pop-up showing
ExamView Learning and Test Center. Click the
Next button to display the log in screen.

5. Enter your instructor ID and password, and then click the Next button.

[ Publish Online Test %

To publish tests to the ExamVisw website, you must have alresdy obtsined an
instructor [0 snd pessword. 11 you do not have an instructor 1D and password,
click the "Register Mow" button.

Step 3: Enter your instructor ID and password.

Ingtructor ID: | jrsmith

Pazzword: | =

Register Mowy...

= Back ][ e = I [ ancel

6. Select the option to determine who may access the test.
You can allow anyone to take the assignment or control access to students in a
particular class. If you do not care about getting student results or how many times

a student completes an assignment, allow access to anyone.

If you want to track your students’ results, you must assign a class. You can create a
roster or import student names and IDs from another file.
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7. Set a password for the assignment and click the Next button.

@ Publish Online Test
Aneone may take an online test, or you can limit access to & paticular group of Afte r you p u bl |Sh

students. To limit access, you must idertify who may take the test. To create a

nevy class or edit an existing class, click the Roster button. an ass | g n me nt ,

E

Step & Specify who should have sccess to the test H
; . you can preview
(@iallow access to anyone: - .
C?Allow access to students in the selected class |t and ed It many

of the settings

Students are required to enter a password before they can access the test. If I nStrUCto r
you wart &ll students ta use the same password, or if some studerts have not
been assigned individual passwords, enter & password below. Ce nte r -

Step 5: Enter a password required to access the test.
Pazzword:

@ Use only for students with no assigned password
() Use for all stucents

= Back ][ hesd = ] [ Cancel

8. Select the remaining online options.

9. Review the summary information, and click the Publish button to upload the
assignment to the website.

After you publish the assignment, you will receive an email that confirms you

published the assignment successfully. The email also includes instructions that you
can provide to your students.
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Access the ExamView Instructor Center

The ExamView Instructor Center provides access to tests you publish via the test-
hosting service. Access the Instructor Center using a web browser on any computer

connected to the Internet.

Using the ExamView Instructor Center, you can...

e Preview a test/assignment.

e Change selected test settings.

e Edit, change, or delete students.
e Access numerous student reports.
e Delete tests.

e Update your account information (ID, password, email address, etc.).

To access the ExamView Instructor Center...
1. Go to the www.fscreations.com/examview.php website.

2. Click the Instructor Center link.

3. Enter your instructor ID and password to log in to the Instructor Center.

4. Link to the desired option to manage tests, view reports, update account

information, etc.

] Instructor Center (Manage Tests) - Microsoft Internet Explorer E]@
 Fle Edit Yiew Favorites Tools Help ;’,’
: - A =y J\-_ i N —3
O Back - 2| Iﬂ \ELI .'\J 7~ Search . Favortes 6:{ = - ‘:“‘
| Address Ej http: f v, examyiew comfinstructor fchoosetest . phpfuserid=eaedefef eSéparm=easfededeeezeceteles V a G0
L3
P TEST SELECTION: Select a test. Click Preview to view a test. Click
Update to view or change the options for the selected test, Click Delete to
permanently remove the selected test and the results (if any) from the
ExamVYiew website, Click Update Class to add, edit, or delete students from
the dlass roster attached to the selected test.
Instructor ID: DEMO
Mame: Jerry Frazier (FSC School)
Log In
» Manage Tests Exarmyiew Practice Test
View Reports Mastering Examiicuw **
Update Registration Sarnple FCAT Math 10 **
Account Infarmation Sample FCAT Math 9 **
Farum Sample Math Practice Test REFRESH
[Cpreview |  [_upDATE | [ DELETE |  [UPDATECLASS
Account Expiration: 12/31/2005 Account Locked
Mote: (**) Indicates tests that have been taken by students.
v)
< b
@'] 8 Internet
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Complete a Test/Assignment via the Internet

Students can take a test or complete an assignment using any computer (Windows or
Macintosh) connected to the Internet (e.g., at school, in a lab, or at home). When you
are ready for students to work online, direct them to the www.evtestcenter.com

website.

To take an online test or complete an assignment...
1. Go to the www.evtestcenter.com website.

2. Enter the Instructor’s ID.

After you log in, you will see a list of the available
tests/assignments.

3. Highlight an item and click the OK button.

When you publish
an assignment,
you get an email
with a link to the
test. Students
can use that link
to skip the log in
process.

@ Select a Test - Microsoft Internet Explorer

. Fle Edit Mew Favorites Tools  Help
" . ~ a = = o
: o <L i ) = 3§
: O Back > ®| @] g o Search 5 7 Favorites 6 = u ‘A‘i

Address | ] http:fww.evtestcenter.com/student ftestselect php

SE]

] B & @ -

]
% Learning & Test Center

STUDENT LOGIN (Specify Test/Study Guide)
P Select a test/study guide and then click OK to take it.
Instructor: Jerry Frazier (FSC Schoal)

Tests/StudyGuides:

Examyiew Practice Test
Sample FCAT Math 10
Sample FCAT Math 9
Sample Math Practice Test

-~

éj Dane

& Internst

4. Enter the student ID or name, and enter the password.

IMPORTANT: If you published a test/assignment with a roster, your students must
enter the ID you assigned to them. If you allowed anyone to access the assignment,

students must enter their name.

5. Complete the test/assignment. Click l® Oroele-S-Submit

J to submit and/or view the

results.
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Get Results from an Internet Test/Assignment

Using the ExamView Test Manager you can download results from the Instructor
Center to your desktop. Then, you can produce reports using the reporting options
provided in the ExamView Test Manager. You can combine results from all of your
assignments (paper, LAN, or Internet) into one convenient location.

Before you can download the results, publish your test/assignment with the ExamView
Test Generator using the various online settings described in the previous sections.
Administer the test or homework assignment to your students.

IMPORTANT: Getting the results from an Internet test is optional since you can access
many reports online at the ExamView Instructor Center. With the test-hosting
service, you can view student results and generate numerous reports online. You do
not have to download the results into the ExamView Test Manager.

To get results from an Internet test/assignment...
1. Publish and administer a test/assignment to the test-hosting service.
2. Start the ExamView Test Manager (if necessary) and open a class.

3. Create an assignment if you have not already done so. Enter the assignment
information and identify the test (.tst) for the program to read the answer key and
other question information (standards, references, etc.).

4. Highlight the assignment. Click t@ or choose Get Results from Internet Test.
5. Enter your instructor ID and password, and click Next.
6. Select the Internet test from the list provided and click Finish to get the results.

The ExamView Test Manager downloads all of the students’ responses and results
from the Internet test-hosting site. If your test includes open-ended questions or
you need to change a student’s score, select the assignment and choose the Edit
Scores option from the Assignment menu.

Notes...

e When you publish an assignment, be sure to save a copy locally on your
computer. The assignment you publish online must match exactly the one you
use to create an assignment in the Test Manager.

e You can administer a test using any combination of paper, local area network
(LAN), or Internet testing options.

e Unlike tests administered via a LAN, you cannot change the settings in the
ExamView Test Manager. You must make any changes to these settings and the
class roster online at the Instructor Center.
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The ExamView Test Manager enables you to prepare a variety of reports based on
your students’ assignment results data. You can print a report for a single assignment,
a group of assignments, or all assignments. You can also easily customize a report to
include selected students filtered by various criteria. Many of the reports include
graphs and charts that provide a visual analysis of the data.

Use the ExamView Test Manager to generate the following class and reports.

Class Reports Student Reports
Assignment Results Assignment Results
Class Assignment Summary Assignment Review
Open-Ended Responses Worksheet Student Progress Report
Item Analysis Summary Learning Focus

Class Roster Performance Summary

Learning Focus
Performance Summary
Class Performance Progress Chart

For each report, you can choose reporting options to control the information included
in the report. Using the filter option, you can generate reports for selected students or
a group of students that match the criteria you set.

Class Reports

The ExamView Test Manager provides numerous reports to help you understand and
evaluate your students’ performance. Depending on your needs, you may prepare one
or more of the class reports to provide useful performance data that allows you to
assess your class as a whole and then determine appropriate strategies to achieve the
learning objectives/standards. With each report, you can control numerous reporting
options to customize the report as desired. This section includes a brief overview and
a sample of each class report.
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Assignment Results

The Assignment Results report provides performance data for each student for a
particular assignment. The report includes the student’s name, ID, points earned, and
percentage achieved. For online test, the report also includes attempts to complete
the assignment, the start time (date and time), and the duration of the assignment
(i.e., the total time to complete the assignment).

The report also includes a separate page with the assignment statistics for the entire
class (i.e., median, mean, low score, high score, range, and standard deviation) and a
graph of the frequency distribution. When you choose this report, you can control
various reporting options. For example, you can choose to show all of the student
information or you can include the ID or alias for each student.

Using the statistical data in the Assignment Results report, you can see how the
majority of the students performed on the assignment. The duration data provides
useful information for future reference; you can calculate the approximate amount of
time required for the students to complete the assignment. Finally, you might use the
Assignment Results report to post the results of an assignment.

Assignment Results
Mr. Robert Abrahms
FSC High Scheol
Math Total Students: 25
Assignment: Reports
Category: Test
Term: 1
Date: 0B/ 4/2005
Points: A0 (50 guestions)
Student 1] Points (%) Attempts  Start Time Duration
Alexander Aber 104681655 45 (90%) 1 0614 2:38pm 0 min., 18 sec
Andy Baba 656526865 et} (TR%) 1 0614 2:38pm Omin, 18 sec
Marman Boghl 379044452 35 (70%) 1 0614 2:3%pm 0 min., 21 sec
Manuel Campag 218031585 43 (BE%) 1 0614 2:39pm 0 min., 20 sec.
Denhise Coston 827044811 + + 4 44 ng et
Wilbert Dowdy 013105510
Chrig Farwell 346695870 )
Michasl Gibhons 431603314 Assignment Results
ken Harmistt 018932958 Mr. Robert Abrahms
Sherman Henderson 152846203 ESCHIghS choal
Jean Hutter 911832166 -
Detlef Katthaus 2039896934 Math Total Students: 25
Catl Kretten 114964396 Assignment:  Reports
Karsten Loeflle BYT982071 Category: Test
Geraldine McDowall 467832015 Term: 1
Date: 061452005
Randalph MNartler 505954704 Points: 50 (50 questions)
Brian O'Neil 653378122 " B oo
Median Mean Low High Range Std. Deviation
Dehbie Pitzer 86B631735 20% T0.7% EO0% 945 4%
Jackie Rhodes 888471963
Esa Saarinen 771354418
Mark Schwartzha 298837995
Aley Sperduti 316036975

# Students

060 o070 0-80 000 0-100

Frequency Distribution
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Class Assignment Summary

The Class Assignment Summary report provides the average for each student for all
assignments or for a particular category (i.e., tests, quizzes, etc.) of assignments. You
can summarize the data for all terms or one term. For example, you can create a
report that shows each student’s average for all tests in the first term.

Over time, the Class Assignment Report provides useful data to help you assess the
performance of your class as a whole. From this information, you might be better
equipped to assess the effectiveness of your teaching strategies and the associated
assignments as they relate to the learning objectives/standards for the class.

Note: In the Class Assignment Summary report, the shaded area ( ) shows the
median performance range for the class and the diamond (+) shows the exact student
average.

Class Assignment Summary

Mr. Robert Abrahms

FSC High School

Math Total Students: 25
Category: All

Term: All

Student 1D Average Points 0% 50%  100% Term 1 Term 2 Term 3 Term 4
Alexander Aber 1046881655 837%  velmss [ ® ] 52.6% 84.3% 84.3% =
Andy Baba 656526965 7e3%  aleas [ ¢ ] 75.4% 72.5% 80%

Narman Boghl 379044483 788% 7450845 56.4% 67.5% 79T%

Manuel Campag 218031585 871% sa3s@as [ #] 90.6% 21.6% 87.8%

Denise Caston 827844811 reE%  tasrmas [ ¢ ] 74.2% 781% 79.4%

wilbert Dowdy 013105510 903% 0535945 [ T+] 9.4% 85.1% 95.1%

Chris Farwell 346635870 TRE% 7431345 742% 76.5% 845%

Wichael Gibbans 431603314 B65% 817945 88.7% 85.1% 85.2%

Ken Harnlett 018922988 7B3% 7215845 [+ 76.2% 73.3% TBE%
Shetrman Henderaon 452946293 801% 7575845 [ #1] 797% 80.4% 80.3%

Jean Hutier 411832186 1% 7851345 | 85.5% 81.2% 76.2%

Dellef Karthaus 203998934 TTA% 7200845 [+ £9.9% 73.8% 826%

Carl Kretten 114964396 822% 777345 82.3% 81.8% 826%

Karsten Loefle 677962071 9% Tapass [ *# 1] 93.2% 722% 0%

Geraldine McDawell 467832015 815% 7706845 7% 72.2% A2.9%
Randulph Nartler 605954704 788% 7450045 1% 21.6% 786%

Brian O'Neil 653378122 934%  7esass [ # ] 93.2% 78.4% a7.2%
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Open-Ended Responses Worksheet

The Open-Ended Responses Worksheet report allows you to score the open-ended
questions that your students complete as part of an online test. Follow these steps to
score open-ended questions and enter the scores into the ExamView Test Manager.

1. After all of your students finish an online test, use the option to get the results
into the ExamView Test Manager. This process reads all of the student responses
for the assignment including the open-ended questions (essay, short answer, etc.).

2. Print the Open-Ended Responses Worksheet. The report includes the open-ended
responses for each student and space for you to write the points earned for each
question.

3. After you complete the worksheet, use the Edit Scores option to enter the results
into the program.

You can use the Open-Ended Responses Worksheet report to work away from your
computer. You can score open-ended questions anywhere and then enter the scores
into the ExamView Test Manager at a convenient time.

Open-Ended Responses Worksheet
Mr. Robert Abrahms
FSC High School
Math Total Students. 25
Assignment:  Chapter 1 - Introduction
Category: Test
Term: 1
Date: 0B 4/2005
Points: a0 (50 gquestions)

Paints Points
Item # Possible  Earned Response
Alexander Aber
46:PR 1 18
4TPR 1 72
48'PR 1 226.2
49:PR 1 301.6
a0:PR 1 9
Andy Baba
46:FR 1 1.8
47PR 1 72
48 PR 1 226.2
49.PR 1 306
a0:PR 1 9
Norman Boeli
46:FR 1 1.8
47PR 1 72
48:PR 1 - 226.2
49.FPR 1 3.6
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Item Analysis Summary

The Item Analysis Summary report provides the percent of the class that answered
each question correctly. For multiple choice questions, the report also shows the
percent of the class that selected each response (or answer choice).

You can use the response analysis in the Item Analysis Summary to identify areas in
which you may want to focus a reteaching activity so that you can better address
particular learning objectives/standards. For questions with a high, correct response
rate, you can use the information to validate the question. On the other hand, if
students consistently answered a question incorrectly, you can assess whether this
points to a problem with the question. For example, suppose students answered a
question overwhelmingly (e.g., 60%) with an incorrect response. This may have
occurred because you recorded an incorrect answer for the question, the question was
unclear, or you did not cover the information adequately in class.

If, in a particular multiple choice question, the student responses are evenly
distributed for all of the answer choices, the analysis may indicate that students
randomly selected a response. If, in another multiple choice question, students
selected the correct response at 65% followed by 30% for the next response. This
response analysis data may point to a common mistake students made in determining
the correct answer for the question. On a question-by-question basis, you should look
for similar patterns; such information can provide insight into your students’
understanding of the material covered by the assignment.

Note: In the Item Analysis Summary report, an indicator (>) appears to the left of a
question that more than 30% of the students in the class answered incorrectly.

Item Analysis Summary
Mr. Robert Abrahms
FSC High School
Math Total Students: 25
Assignment:  Chapter 1 - Introduction
Category: Test
Term: 1
Date: 086/ 42005
Points: 50 (50 guestions)
Class
Question  Average A B C D
Multiple Choice
1 97% 8% 92% 0% 0% 0%
2 24% 12% 4% 84% 0% 0%
3 a0% 0% 80% 20% 0% 0%
> 4 68% 4% 0% 28% 68% 0%
L} 96% 4% 96 0% 0% 0%
G 96% 0% 4% 0% 96% 0%
7 88% 0% piial) 4% 8% 0%
2 100% 0% A00%: 0% 0% 0%
4 96% 4% 0% 0% 96% 0%
10 100% 0% 0% 0% 100% 0%
1 100% 0% 0% 0% 100% 0%
12 28% 0% 4% a8t 2% 0%
13 96% 0% D6 4% 0% 0%
14 100% 0% 0% 0% 100% 0%
15 28% 12% 0% 88% 0% 0%
16 100% 0% 0% 0% 100% 0%
17 88% 4% pitialy 0% 8% 0%
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Class Roster

The Class Roster report generates an alphabetical list of the students in a particular
class. You can create a filter to include all of the class or selected students.
Additionally, you can customize the Class Roster report by choosing to include the
supplemental student information (i.e., ID/alias, password, grade, date of birth,
sociological/economic, etc.).

You might use this report to have a printed record of the ID/alias and password for
each of the students in each class. You could then conveniently reference this printout
if a student forgets their ID, alias, or password. However, to maintain privacy of the
IDs, you would want to keep the printout in a safe place where students and others
could not access the information.

Class Roster

Mr. Robert Abrahms

FSC High School

Math Total Students: 25
1D/ Sociological! Race/

Student Alias Password Grade Date of Birth Economic Ethnicity QOther Custom

Alexander Aber 104681655 Aber

her

Ancly Baba 656526865 Baha
Baba

Marman Boehl 379044438 Boshl
Blaehl

Manuel Campag 218031585 Campag
Campag

Denise Coston S27844811 Coston
Coston

Wilbert Doy 013105510 Dovaely
Dovaddy

Chriz F arael 34BES5ET0 Farasl
Fareel

Michael Gibbons 431603314 Gibbons
Gibbons

Ken Ham|ett 018922988 Hamlett
Hamlett

Sherman Henderson 452946293 Henderson
Henderzson

Jean Hutter 911832168 Hutter
Hutter

Detlef Karthaus 203996834 Karthaus
Karthaus

Carl Kretten 114964336 Kretten
Kretten

Karsten Loeffle B77962071 Loeffle
Loefile

Geraldine McDaovell 467832015 McDowel
M cDawel
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Learning Focus

The Learning Focus report provides a wealth of information to help you identify areas
where your class (as a whole) needs to focus their learning efforts. To use this report
effectively, the assignments you create must consistently include data for one or more
of the following fields: learning objective, local standard, state standard, or national
standard.

One of the key advantages for using the ExamView Test Manager is that you can easily
gather performance data over multiple assessments. The report shows the number of
items for each standard. That way, you can gauge whether a standard was adequately
covered. You can select one or more assignments by category or by date. You must
also identify a focus range (e.g., 0% - 70%). The program produces a report that shows
each standard (or learning objective), the number of questions assessed for that
standard, class average, and how many students are in the focus range.

Note: The shaded area ( ) shows the performance for the median 70% of the
students in your class. For example, if there are 20 students in your class, the top 3
scores (15%) and lowest 3 scores (15%) would not be included. The range of scores
represents 14 students or 70% of the class. The diamond ( + ) shows the actual class
average. Use the graphs to see how the majority of students performed. If the area is
relatively short, students’ scores were similar.

Learning Focus
Mr. Robert Abrahms
FSC High School

Math Total Students: 25
Category: All
Date Range: September 1, 2004—April 15, 2004
Focus Range: 0% to 70%
Proficiency Target: &t or above 70%
# Students Class
Learning Ohjective # ltems 0% 50%  100% in Range Proficient Average
Adds, subtracts, multiplies, and divides real m [ % ] 25 0 54.4%
numbers, including sguare roots and
exponents, using appropriate methods of
computing, such as mental mathematics, paper
and pencil, and calculator.
Students in Focus Range:
Alexander Aber Andy Baha Maorman Boehl Manuel Campag
Denise Coston Wilbert Dowdy Chris Farwell Michael Gibbons
ken Hamlett Sherman Henderson Jean Hutter Detlef Karthaus
Carl Kretten Karsten Loeffle Geraldine McDaowell Randalph Martler
Brian C'Meil Debhie Pitzer Jackie Rhodes Esa Saarinen
Mark Schwartzha Alex Sperduti Michael Taeschn Danny Tucker
JeffWallace
Analyzes and applies geometric relationships 10 T 15 81.6%
involving planar cross-sections the intersection
of a plane and a three-dimensional figure).
Students in Focus Range:
Morman Boehl Michael Gibbons Karsten Loeflle Jackie Rhodes

Esa Saarinen Mark Schwartzha Jeffiallace
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Performance Summary

The Performance Summary report provides a summary of your class’ performance for
all class assignments in a category over a specified date range. The Performance
Summary report lists a learning objective/standard, the number of items (i.e.,
guestions) that assess that objective/standard, and the proficiency level that the class
as a whole has attained.

To use the Performance Summary report effectively, you must consistently include
guestion information for one or more of the following fields in each of the items you
create: learning objective, local standard, state standard, or national standard. (Many
publishers include this information for the questions they provide.)

You can customize the Performance Summary report to generate the performance
data that best meet your needs. You can select the date range for the class
assignments, and you can set an appropriate proficiency target (e.g., 70% and above)
for the class assignments at a particular time in the term. As an example, you might
set the proficiency target at 70% with the first class assignment that covers a
particular learning objective/standard. Then, on a subsequent class assignment on the
same learning objectives/standards, you might set the proficiency target at 80%.

Performance Summary
Mr. Robert Abrahms
FSC High School

Math Total Students: 25

Category: All

Date Range: September 1, 2004—April 15, 2004
Proficiency Target:  at or above 70%

# Students Class
#ltems 0% 50%  100% Proficient Average

L+ 1 0 54.4%

Learning Objective

Adds, subtracts, multiplies, and divides real 10
numbers, including souare roots and

exponents, using appropriate methods of

computing, such as mental mathematics, paper

and pencil, and calculator.

Students Proficient:
(Mone)

L+ 18 B1.6%

Analyzes and applies geometric relationships 10
invalving planar cross-sections (the intersection
of a plane and a three-dimensional figure).

Students Proficient:

Alexander Aber Andy Baba Manuel Campag Denise Coston
Wilbert Dowdy Chris Farwell Mizhael Gikhons Ken Hamilett
Sherman Henderson Jean Hutter Detlef Karthaus Carl Kretten
Geraldine McDiowell Randalph Martler Brian O'Neill Debhie Pitzer

Alex Sperduti

Michael Taeschn

Danny Tucker
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Class Performance Progress Chart

The Class Performance Progress Chart report shows at a glance how each student is
performing on each of the learning objectives/standards for all assignments in a
category over a specified date range. The report lists a learning objective/standard,
the number of items (i.e., questions) that assess that learning objective/standard, and
a proficiency indicator for each of the students.

To use the Class Performance Progress Chart report effectively, you must
consistently include question information for one or more of the following fields in
each of the items you create: learning objective, local standard, state standard, or
national standard. (Many publishers include this information for the questions they
provide.)

To customize the Class Performance Progress Chart, you can set the category of
assignments, the date range of the class assignments, and the proficiency level based
on your performance criteria. The report shows one of three icons (O © Q) to
indicate each student’s performance on each of the learning objectives/standards.

Performance Progress Chart
Mr. Robert Abrahms
FSC High School

Math Total Students: 25
Category: All
Date Range: Septermber 1, 2004—April 15, 2004

Proficiency Levels: {0 0%-70% O 70%-85% {0 85%-100

Class Alexander Ay Horman Mamuel Denise Wilbert Chris
Leaming Objective Eltems Average Aber Baba Boehl Campag Coston Dowly Farwell
Adds, subtracts, multiplies, and divides real 10 O o o o 9] ] o o

numbers, including sguare roots and

exponents, using appropriate methods of

computing, such a3 mental mathermatics, paper

and pencl, and calculator.

Analyzes and applies geometric relationships 10 o o o o 9] 9] o o
involving planar cross-sections (the intersection

of a plane and a three-dimensional figure).

Designs and performs reabworld statistical 10 o o o o 9] 9] o o
experiments that involve mare than ane variable,

then analyzes results and reports findings.

Interprets data that have been collectad, 10 o o o o o 9] o o
organized, and displayed in charts, tables, and

plots.

Understands that numbers can be represented 10 o o o o 9] 9] o o

in & variety of eguivalent forms, including
integers, fractions, decimals, percents, scientific
notation, exponents, radicals, absolute value,
and logarithrms.
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Student Reports

The ExamView Test Manager provides five reports that highlight each student’s
individual performance for one or more assignments. This section includes a brief
overview and a sample of each student report.

Assignment Results

The Assignment Results report reflects a student’s performance for one assignment.
The report includes the following information: assignment average, points earned for
each question, and the student’s response for each question.

If you select the option for performance results for learning objectives/standards, the
Assignment Results report also includes each learning objective and the following
performance data for that learning objective/standard: the average, points earned,
the proficiency level, and the specific questions in the class assignment. To use the
Assignment Results report effectively, you must consistently include question
information for one or more of the following fields in each of the items you create:
learning objective, local standard, state standard, or national standard. (Many
publishers include this information for the questions they provide.)

You can use this report to identify each student’s proficiency level for each of the
learning objectives/standards for each assignment. This information may also help you
to identify areas in which a student may need remedial work.

Assignment Results
Mr. Robert Abrahms
FSC High School

Alexander Aber Average: 90% usisn
Assignment:  Chapter 1 - Introduction
Category: Test
Term: 1
Date: 0Bf1472005
Points: 0 (30 questions) Assignment Results
. . Mr. Robert Abrahms
Question  Points Your Response FSC High School
Multiple Choice
1 1M B
2 10 = Alexander Aber Average: 90% wusisn
3 "M B
4 10 D Assignment:  Chapter 1 - Introduction
5 11 B Category: Test
Term: 1
B 1m D Date: 0614520035
7 1n B Points: &0 (50 questions)
8 1M B . — . . . . .
5 " o Learning Objective Average  Points 0% 50% 100% Questions
10 m ) Adds, subtracts, multiplies, and divides real B0% 1o MC:40, 41, 42,43,
numbers, including sgquare roots and 44,45 PR:47, 48,
1 " o exponents, using appropriate methods of 49,50
computing, such as mental mathematics,
12 10 c paper and pencil, and calculator.
13 n = Analyzes and applies geometric 100% 1010 I: MC:20, 21,22, 23,
14 m D relationships imvolving planar 24,125,268, 27,28,
15 19 I cross-sections the intersection of a plane 29
and a three-dimensional figure)
16 i D Designs and performs reakworld statistical 100% 1010 I: MC:5 B, 7,8 9,15,
17 101 B experiments that invalve more than one 16,17,18,13
13 n o variable, then analyzes results and reports
findings
19 n o]
Interprets data that have heen collected, 90% 910 Ijl MC,2, 3, 4,10,
arganized, and displayed in charts, tables, 11,12,13,14;
and plots. PRA4E
Understands that numbers can be 100% 1010 : MC:30, 31, 32, 33,
represented in a wariety of equivalent forms, 34,35, 36, 37, 38,
including integers, fractions, decimals, 38
percents, scientific notation, expanents,
radicals, absolute walue, and logarithms.
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Assignment Review

The Assignment Review report provides a tool to help your students understand the
mistakes they made on an assignment. For each question answered incorrectly, the
report shows the following: points earned, student’s response, correct answer,
explanation, study tip, and focus area (depending on the information available).

To use the Assignment Review report effectively, you must consistently include extra
question information for each of the items you create. (Many publishers include this
information for the questions they provide.) For example, a study tip such as Refer to
pp. 23-25 is the information in the Reference field for a question. Students, in this
example, could use the report to refer to the specified pages in their textbook as they
review the questions that they answered incorrectly.

Students can use the Assignment Review report to review the completed assignments
and to learn from their mistakes.

Assignment Review
Mr. Robert Abrahms

FSC High School

Math

Alexander Aber Score: 91% @samsn
Assignment:  Chapter 1

Category: Test

Term: 1

Date: Q7082005

Points: 50 (80 questions)

Based on your results for this assigniment, review the study tips below,

Question Review

Miritipfe Choice

4 (0§ Your Response: © Correct Answer: D
Rationale:

Saturn has 19 satellites; Neptune has &

Reference: Science

Multiple Choice
27 (1) Your Response: A Correct Answer: C
Rationale:
The cross-section 15 a rectangle with length 19 feet and width 2 « 8.6 =17.2 feet.

A=ixw
A=19(172)

A 326.8 e

Reference: Mathematics
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Student Progress Report

The Student Progress Report shows a student’s progress for one or more terms. The
report organizes the results by term and provides the following information for each
assignment: assignment description, date assigned, category, points earned, percent
achieved, and class average. A summary shows the term average by listing the total
points earned out of the total possible points, the equivalent percent, and the class
average.

You can use the Student Progress Report to depict the student’s progress over time.

Student Progress Report
Mr. Robert Abrahms
FSC High School

Alexander Aber Overall Average: 86.9%
Category: All
Term: All
Class

Assignment Date Category Points Percent Average
Term 1
Math G6 Exam 06/08f2005 Exam 50i50 100% 87.5%
Math GE Quiz 06/09r2005 Quiz ano 0% G6.5%
Math GE Test 081072005 Test 20120 100% TE.4%
Reading 53 Exam 0611112005 Exam 100/100 100% B9%
Reading G3 Quiz 061272005 Fop Quiz 1814 100% 73.9%
Reading G3 Test 0611372005 Test 38i40 5% 80.8%
Reading G9 Exam 061412005 Test gnoa 78% 80.6%
Reading GY Quiz 0B/14/2005 Hormewrk ann 20% 78.4%

Termm Average: 318/345 92.2% 1.9%
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Learning Focus

The Learning Focus report identifies areas where a student needs to focus his/her
learning efforts. Based on a proficiency level you set, the report lists the learning
objective/standards that a student has not mastered. For each of the learning
objectives/standards the student has not yet mastered, the Learning Focus report
lists the learning objective/standard, the associated number of items, the points
earned on items, and the proficiency level that the student has attained.

You can customize the Learning Focus report to generate the performance data that
best meet your needs. You can select one or more class assignments by category and
the date range for the assignments. You can set an appropriate focus range (e.g., 0% -
70%) for the class assignments at a particular time in the term. As an example, you
might set the focus range at 0% to 70% with the first class assignment that covers a
particular learning objective/standard. Then, on a subsequent class assignment on the
same learning objectives/standards, you might set the focus range to 0% to 80%.

You can use the Learning Focus report to help a student know exactly what to study
in order to attain mastery level on the identified learning objectives/standards.

Learning Focus
Mr. Robert Abrahms
FSC High School

Alexander Aber

Category: All

Date Range: September 1, 2004—April 15, 2004

Focus Range: 0% to 70%

Learning O bjective # ltems Average Points 0% 50%  100%

Adds, subtracts, multiplies, and divides real 10 B0% 610
numbers, including sguare roots and

exponents, using appropriate methods of

computing, such as mental mathematics,

paper and pencil, and calculator.

Designs and performs reakwarld statistical 10 60% 610
[+

experiments that involve more than ane
variahle, then analyzes results and reports

findings.
Interprets data that have been collected, 10 T0% o
organized, and displayed in chars, tables,
and plots.
Note: The shaded area ( ) shows the performance for the median 70% of the

students in a class. For example, if there are 20 students in a class, the top 3 scores
(15%) and lowest 3 scores (15%) would not be included. The range of scores for 14
students (70%) would be represented. The diamond ( + ) shows your student’s actual
performance. Use the graphs to see how a student performed in relation to his/her
class. For example, if the diamond appears near or past the right edge of the shaded
area, the student’s performance is in the upper range for the class. If the shaded area
is relatively short, students’ scores were similar.
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Performance Summary

The Performance Summary report shows at a glance how a student is performing on all
learning objectives/standards for all assignments in a category over a specified date
range. The Performance Summary report lists each learning objective/standard, the
number of items (i.e., questions) that assess each learning objective/standard, a
proficiency score for each learning objective/standard, whether the student is
proficient based on the proficiency target, and the average for each learning
objective/standard.

To use the Performance Summary report effectively, you must consistently include
guestion information for one or more of the following fields in each of the items you
create: learning objective, local standard, state standard, or national standard. (Many
publishers include this information for the questions they provide.)

You can use the Performance Summary report to identify specific learning
objectives/standards where the student needs to focus his/her learning efforts.

Performance Summary
Mr. Robert Abrahms
FSC High School

Alexander Aber

Category: All

Date Range: September 1, 2004—April 15, 2004

Proficiency Target:  at or above 70%

Learning O hjective # ltems 0% 50%  100%  Proficient? Average
Adds, subtracts, multiplies, and divides real 10 Mo B0%

numbers, including sguare roots and
exponents, using appropriate methods of
computing, such as mental mathematics,
paper and pencil, and calculator.

Analyzes and applies geometric 1w [ T4 Yes 100%
relationships invalving planar

cross-sections (the intersection of a plane

and a three-dimensional figure).

Diesiogns and perfarms reakwaorld statistical 10 |I| Mo B0%
experiments that involve more than one
variahle, then analyzes results and reports

findings.

Interprets data that have heen callected, 10 II| Yes 70%
argarized, and displayed in charts, tables,

and plots.

Understands that numbers can be w [ T4 Yes 100%

represented in avariety of eguivalent forms,
including integers, fractions, decimals,
percents, scientific notation, exponents,
radicals, absolute walue, and logarithms.
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Print a Report

After ExamView Test Manager prepares a report, you can print the report in just a
few simple steps. When you are ready to print a report, follow these general
instructions. Numerous report options allow you to customize the information that
appears on the printout. For detailed instructions and options, see the corresponding
help topic in the application.

To print a report...

1. Click the Report menu and choose a report.
You can set a

filter to print
only selected
students based on
various criteria.

2. Select the report options.
3. Click the OK button to display the report.

4. While viewing the report, click the Print button to
send the report to the printer.

Export Results to a Gradebook or Another Application

The ExamView Test Manager lets you export the students’ results data for an
assignment. You can export summary data (e.g., student name, ID, and percentage) or
detailed data (e.g., student information, all responses, answer key, etc.). With the
export option you can export student results in order to import them into your
gradebook or a spreadsheet. For more advanced users, you can export the results for
use with a student information system.

To export the results for an assignment...
1. Select an assignment.

2. Choose Export and then select the Current Assignment as Text or Current
Assignment as XML option.

Use the as Text option to export results for use with a gradebook or a spreadsheet
program. Use the as XML option to export results to a student information system.

3. Set the options (if necessary) and then enter a file name.
Note: You can also use the Copy All Class Records option in the Edit menu to copy

all of the information in the work area. Then, you can paste that information into a
spreadsheet document.
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Using the ExamView Test Generator, you can publish any test as an HTML document.
You can choose to create a self-grading study guide or a test that will send student
results to you via email. After you publish the test, you must copy the files to your
website so that your students can access the test.

Publishing an HTML test is a quick way to create an

online test. However, these disadvantages exist: (1) you The ExamView
must have your own website and know how to upload Test-Hosting
files; (2) there are no settings to control when and who Service provides
may access a test; (3) results are not stored in a a more robust
database for access at a later time; and (4) getting Internet testing
results via email can be unreliable due to network and study
settings and spam filters. solution.

For many situations, the HTML testing features provide a
an acceptable solution to meet a variety of online testing needs. Review the
instructions in this section to learn how to publish an Internet (HTML) test.

Publish an Internet (HTML) Test

Follow the instructions below to set the features for the online test and save it to your
hard drive.

To publish an Internet test...
1. Start the ExamView Test Generator and create or open a test.
2. Click @ or choose Publish Online Test from the File menu.

3. Choose the Save the test as an HTML document to your hard drive option. Click
the Next button to display the test options.

[ Publish Online Test &

Usg this option to create an HTML study guide or test that you can host on your
own websie.

Step 3: Choose to publish & study guide or a test
(O}
MOTE: If you select the study-guide option, students can compare their

responses to the correct answers upon completion of the study guide.
Reszults will NOT be recorded or emailed to you.

=2

=3 DShow Feedback I:‘Shnw Reference

) Publish a test
I:‘ Showy test score to student

Formal name:

Send results to email address:

MNOTE: If you select this option, you wil receive a detailed report via email
for each student. Students will not be bl to review their responses

once they submit the test for grading

<Back || Med= | [ cancel |
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4. Choose to publish a study guide or a test and click the Next button.

A study guide is a self-grading test. You can choose

to show the rationale, feedback, and reference if Stud_ent feedback
. L . . can include a

your test includes this information. Doing so makes hyperlink to

the study guide a true learning experience rather remedial learning

than just telling the students that an answer is right material.

or wrong.

Choosing a test allows students to take it online, and

you receive a separate results email for each student. You must include a valid
email address. You also have the option to show a student his/her results after
completing a test. The results email will contain the student name and his/her
score.

5. Click the Save button to save the HTML document and image files to your hard
drive.

When you publish an online test, the ExamView Test Generator saves an HTML file
and all of the supporting images. The images are stored in a folder named similar to
the test file.

@j chapter_1.htm

Cchapter_1_files
1| chkwork, gif
1| correct.qif
,il header.gif
,il help.gif
|§1] mco01-1.jpg
|§1 mc001-2.jpg

6. Copy the HTML file and the folder with its contents to your website. Do not change
anything including the folder name.

Note: If you do not know how to copy files to your website and set a hyperlink,
contact your technology support person. The process varies depending on your
particular system.

7. Preview the test before your students take it.
For tests, answer some or all of the questions. Then, click the Grade & Submit

button and make sure that you receive a results email. It’s very easy to enter the
wrong email address. Doing so will cause you to not receive any emails.
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Take an Internet (HTML) Test

After you publish an HTML test and copy it to your website, your students can take the
test anytime from anywhere they can access the Internet. You must provide your
students with the website address (URL) for them to access the test.

To take an Internet test...
1. Start your web browser.

2. Enter the website address to go directly to the test or to a page with a hyperlink to
the test.

&1 Sample EV Test 2 - Microsoft Internet Explorer [Z]@
: Ele Edt View Favorites Tools Help ','

IERE v | search Favorites Iv fg = 3
s @ Ci\chapter_1.htm [v| B o

3 @ WSs1 Q Examiew Ej EV Forum ,@j EV Register ,g] SalesForce EJ FSC Webex ,g] Education Week =
i
Name:
Sample EV Test 2
Multiple Choice

Identify the letter of the choice that best completes the statement or answers the guestion.

Tv| 1. ExamView includes a toclbar that increases productivity for both first-time users and advanced users.
Which of these buttons is an example of an ExamView toolbar button?
a EI b. _Eil c @;l d ;%_l . all of these

2. The test generator software provides support for the following picture formats: bitmap (.bmp), TIFF (tif),

JPEG (.jpg). and Macintosh PICT (pct). As demonstrated below. which of the advanced features does
ExamView offer?

Text e mR -

Ev

Set the baseline for an image.

| Use color, black and white, and grayscale

ext .
T images.

by BN d all of these

Resize an image.

["T+] 3. With the ExamView QuickTest Wizard you can create a testin
T a 5 hours b, 3 minutes c. 2seconds d 4 days

: [w| 4. ExamView lets vou create paper tests, computerized (LAN-based) test. and <
B a Internet tests c. eyetests
b. driving tests d. none of these

éj Done _a My Computer

3. When the test appears, enter your name (and email/ID if requested).

4. Complete the test.

5. When you finish your online work, click the Check Your Work button for a study
guide or the Grade & Submit button for a test.

Note: For a test, you will receive a results email for each student shortly after the
student clicks the Grade & Submit button.
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The ExamView Assessment Suite works with both the WebCT and Blackboard course
managements systems. You can easily upload a test from the ExamView Test
Generator to either one of these applications. Simply create your test, choose to
export it, and a wizard will guide you through the process.

& WebCT

To export a test...
1. Start the ExamView Test Generator and create or open a test.

2. Choose Export from the File menu, and select either

WebCT or Blackboard. Be sure to c_heck
the FSCreations

website for free
updates to the
export program.

IMPORTANT: The export option is only available on
the Windows version.

3. Follow the instructions in the wizard to upload the
test.

For step-by-step instructions, click the Help button that appears while you are
working with the wizard.
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Technical Support

Before contacting technical support, please check the following:

e Is your computer working properly? Try some other software, which you know is
working, on the same computer.

e Try the software on another computer.

e Can you repeat the problem? Does the problem occur at the same point each
time?

In order to help you as quickly as possible, have the following information available
before you contact technical support:

e Version of the software (e.g., 5.01) from the start-up splash screen
e Brand, model, and configuration of the computer you are using

e System version (Windows XP, Windows 2000, OS X 10.2, etc.)

o The exact wording of any error message

Before you contact us, you may want to search our online support forum. Go to our
website (www.fscreations.com) and click the support link.

If you cannot find a solution to your problem on the forum, send us an email at
support@fscreations.com. If you need to reach us by telephone, you can find the
number on our website in the support area.

IMPORTANT: If you received the software from your publisher, contact them directly
for technical support. Refer to your publisher’s website to obtain the technical support
contact information.

Using the ExamView Assessment Suite with Other Applications

Many other products work with the ExamView Assessment Suite software and its
content. For example, you can deliver a practice test that works with a quiz show
program or use the test on a handheld (e.g., Palm or PocketPC). The ExamView
Assessment Suite also works with several bubble sheet scanners to make grading your
tests quick and easy.

For a complete list of the products that work with the ExamView Assessment Suite, go
to our website (www.fscreations.com).
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